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OUTLINES
Microsoft Access Training

1) Introduction to Databases

2) Introduction to Objects

3) Getting Started in Access

4) Working with Tables

5) Dealing with Existing Database

6) Creating a New Database

7) Working with Forms

8) Sorting and Filtering Records
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1. INTRODUCTION 
TO 

DATABASES
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 What is Microsoft Access?

Microsoft Access is a relational 
database management system (DBMS 
or RDBMS). 

At the very core, it is a software 
“engine” that provides an interface 
between physical data and user 
application queries.

1. Introduction to Databases

Examples of DBMS

 Oracle
 mySQL
 SQL Server (Microsoft)
 DB2 (IBM)
 Informix
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 Why choose MS-Access over MS-Excel?

1. Introduction to Databases
Cont’d

Although there is always overlap, the following rules might help 
when deciding when / when not to use MS Access:

 MS Access is best used for long-term data storage and/or data 
sharing.

 MS Excel is best used for minor data collection, manipulation, and 
especially visualization.

 It is easy to export data from MS Access to Excel
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 Why choose MS-Access over other DBMS systems?

1. Introduction to Databases
Cont’d

o Microsoft Access is cheap, readily available (packaged with 
MS-Office Premium).

o Easy to use (relative to other systems, Oracle may require 
one FTE to maintain the server as a database administrator 
and another FTE to serve as an application developer).

o Includes front-end tools for rapid application development 
(RAD).  This also makes MS-Access a good prototype 
environment.
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 Why choose other DBMS systems over MS-Access?

MS-Access can handle a large number of records, but is 
somewhat slow compared to some of the high-end platforms.

Multiple users may use the database simultaneously, but 
MS-Access is known to become unstable with greater than 
3-5 users.

1. Introduction to Databases
Cont’d
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 MS-Access

MS-Access is a database creation and management program. 
To understand MS-Access, you must first understand databases.
In this lesson, you will learn:

 About DATABASE and how they are used. 

 You will familiarize yourself with the differences between data 
management in MS. ACCESS and Microsoft EXCEL. 

 Finally, you will get a look ahead at the rest of the Access course.

1. Introduction to Databases
Cont’d
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A DATABASE:
-is an organized collection of data, facts about people, events, 

things, or ideas related to a specific topic or purpose. 

INFORMAITON:
-is data that is organized in a useful manner.

DATA:
-are the facts and statistics collected in the raw form for 
reference or analysis whereas information is processed data.

1. Introduction to Databases
Cont’d
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• Access 2007, 2010 and 2013 databases end 
with .accdb file extension – for example, 
sales.accdb

• Databases made in older versions of Access 
have the file extension .mdb

1. Introduction to Databases
Cont’d
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What is a database?

 A database is a collection of data that is stored in a computer 
system. 

 Databases allow their users to enter, access, and analyze their 
data quickly and easily.

Example:

 doctor’s receptionist entered your personal information into a computer
 Or watched a store employee use a computer to see whether an item was in 

stock?

1. Introduction to Databases
Cont’d
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For instance, if you like to 
bake you might decide to 
keep a database containing 
the types of cookies you 
know how to make and the 
friends you give those 
cookies to. The simplest 
databases contain two lists: a 
list of your friends, and a list 
of cookies.

1. Introduction to Databases
Cont’d
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1. Introduction to Databases
Cont’d

If you were a professional 
baker you would have many 
more lists to keep track of:
 a list of customers, 
 a list of products sold, 
 a list of prices, a list of 

orders

Note:
The more lists you add, the more 
complex the database will be.
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1. Introduction to Databases
Cont’d

MS-Access stores its lists of data in tables, which allow you
to store even more detailed information. In the table below, the 
“People” list in the amateur baker’s database has been expanded
to include other relevant information about the baker’s friends.

A relational database is able to understand how lists and the objects within them 
relate to one another.
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1. Introduction to Databases
Cont’d

The simple database with 
two lists: 
names of your friends, and
the types of cookies you 
know how to make. You 
decide to create a third list to 
keep track of the batches of 
cookies you make and
who they’re for.
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1. Introduction to Databases
Cont’d

The fact that relational databases can 
handle information this way allows you 
to enter, search, and analyze data in 
more than one table at a time.
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1. Introduction to Databases
Cont’d

• Determine the information you want to keep 
track of to create a new database. 

• Ask yourself, “What questions should this 
database be able to answer for me?” 

• The purpose of a database is to store data in 
a manner that makes it easy for you to get 
the information you need.

Guidelines for Designing Databases
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2. INTRODUCTION 
TO 

OBJECTS
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2. Introduction to Objects

Databases in Access are composed of four 
objects: tables, queries, forms, and 
reports.
Together, these objects allow you to enter, 
store, analyze, and compile your data as 
you wish.
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What is Field?

A collection of records that identify a category of data, such as Customers, 
Orders, or Inventory. Store the data in a database – similar to a spreadsheet, but 
more organized.  Contains records (rows) and fields (columns).

What is Record?

A set of related field values.

A single characteristic or attribute of a person, place, object, event, or idea.

What is Table?

2. Introduction to Objects
Cont’d
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2. Introduction to Objects
Cont’d
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Table

2. Introduction to Objects
Cont’d
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Although tables store all of your data, the other 
three objects offer you ways to work with it: 
forms, queries, and reports. Each of these 
objects interacts with the records stored in your 
database's tables.

o Forms, queries, and reports

2. Introduction to Objects
Cont’d
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What is Form?

 Forms are used for entering data, displaying 
data or for building a menu system.

o Basic Forms, 

o Split Forms, 

o Multiple Item Forms, 

o Sub-forms

2. Introduction to Objects
Cont’d
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Form 

2. Introduction to Objects
Cont’d
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What is Queries?

 Allow you to ask questions (queries) about data in the database 
to extract information.

 When have customers (placed orders)?

 What products in inventory haven’t (sold well)?

Queries are a way of searching for and compiling data from one 
or more tables. 

When you build a query in Access, you are defining specific 
search conditions to find exactly the data you want.

2. Introduction to Objects
Cont’d
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Query 

2. Introduction to Objects
Cont’d
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What is Report?
 Used to format and present the data in a professional, 

logical and useful manner.  Often intended for printing
and distribution. Can be built from tables or queries.

 Reports (output) in a system dictate what data must be 
stored in the database.

 Report, Layout and Design view and Print Preview

 Access offers you the ability to create a report from any 
table or query.

2. Introduction to Objects
Cont’d
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Report

2. Introduction to Objects
Cont’d
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 Illustration of Fields, records and a Table

2. Introduction to Objects
Cont’d
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Every piece of data that a 
query, form, or report uses is 
stored in one of your database 
tables.

Putting it all together

2. Introduction to Objects
Cont’d
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Putting it all 
together

2. Introduction to Objects
Cont’d

XP

Data Management 2 MS... Access Training by MRRD/NORPLAN
33

As an 
example if 
you Search 
for a book at 
the library?

2. Introduction to Objects
Cont’d
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3. GETTING 
STARTED IN 

ACCESS
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3. Getting Started in Access

Double click on the 
Microsoft Access icon 
on the desktop.
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3. Getting Started in Access
Cont’d

Whenever you're learning a 
new program, it's important 
to familiarize yourself with 
the program window and 
the tools within it.
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This picture gives you the 
option to: 

1. Create a New Database from 
scratch 

2. Use the wizard to create a 
New Database 

3. Open an existing database 
The white box gives you the most recent 

databases you have used. If you do not see 
the one you had created, choose the More 
Files option and hit OK. Otherwise choose 
the database you had previously used and 
click OK. 

3. Getting Started in Access
Cont’d

XP

Data Management 2 MS... Access Training by MRRD/NORPLAN
38

Working with your Access environment  (The Ribbon):

3. Getting Started in Access
Cont’d
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To minimize and maximize the Ribbon:

3. Getting Started in Access
Cont’d
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The Quick Access 
Toolbar

The Quick Access Toolbar is 
located above the Ribbon. By 
default, it shows the Save, 
Undo, and Repeat commands. 

3. Getting Started in Access
Cont’d
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The Navigation 
Pane

The Navigation Pane is a 
list containing every object 
in your database. For 
easier viewing, the objects 
are organized into groups
by type. You can open, 
rename, and delete objects 
using the Navigation Pane.

3. Getting Started in Access
Cont’d
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To minimize and Maximize the Navigation Pane:

3. Getting Started in Access
Cont’d
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Databases with navigation forms

Some databases include a navigation form 
that opens automatically when the database 
is opened. Navigation forms are designed
to be a user-friendly replacement for the 
Navigation Pane. 

3. Getting Started in Access
Cont’d

XP

Data Management 2 MS... Access Training by MRRD/NORPLAN
44

Navigation 
Form

3. Getting Started in Access
Cont’d
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4. WORKING WITH 
TABLES
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4. Working with Tables

Table basics

If you're new to Microsoft Access, you'll need to learn the 
basics of working with
tables so you can open, navigate, add information, and edit 
them.

1. Open your database, and locate the Navigation Pane.
2. In the Navigation Pane, locate the table you would like to open. Tables are 

marked with the icon.
3. Double-click the name of the table. It will open and appear as a tab in the 

Document Tabs bar.
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4. Working with Tables
Cont’d
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4. Working with Tables
Cont’d

In Access, rows and columns are referred to as records and fields
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4. Working with Tables
Cont’d

A field is a way of 
organizing 
information by type. 
Think of the field 
name as a question, 
and every cell within 
that field as a 
response to that 
question.
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4. Working with Tables
Cont’d

A record is one unit of information. Each record has its own ID number.
ID number is unique to its record. The ID number for a record cannot be changed.
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4. Working with Tables
Cont’d

Navigating within tables

To navigate through records in a table, you can use the up and 
down arrow keys, scroll up and down, or use the arrows in the
record navigation bar located at the bottom of your table. 

You can also find any record in the currently open table by 
searching for it using the record search box. Simply place your 
cursor in the search box, type any word that appears in the 
record you would like to find, and press Enter. 
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4. Working with Tables
Cont’d

To view additional 
records that match 
your search, press 
Enter again.

Navigating within 
tables Cont’d

To navigate between 
fields, you can use the 
left and right arrow keys 
or scroll left and right.

XP
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• Datasheet View – used to add, modify, delete and view records

• Design View – used to create and modify the fields in a table 

Datasheet View

Design View

4. Working with Tables
Cont’d
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• Primary Key – a field that identifies each record as being 
unique

Primary key field

Navigation bar
Scroll barNavigation buttons

Datasheet 
View

of Table

4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN
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• Click F6 to 
switch between 
the upper and 
lower panes

Key symbol identifies primary key field

Set field properties in the 
lower pane

Design View
of Table

4. Working with Tables
Cont’d
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• Forms, queries, and reports are all based upon data 
contained in a table

Report Query Form

4. Working with Tables
Cont’d
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To add a new record:
There are three ways to add a new record to a table: 

I. In the Records group on the Home tab, click the New command.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To add a new record Cont’d:

II. On the Record Navigation bar at the bottom of the window, click the New 
Record button.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To add a new record Cont’d:

III. Simply begin typing in the row below your last added record.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To add a new record Cont’d:

Occasionally when you enter information into a record, a window will pop up to tell 
you the information you've entered is invalid. 
Click OK, then follow the instructions in the pop-up window to re-enter your data.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To save a record:  Select the Home tab, and locate the Records group.
 Click the Save command

Note: Be sure to save any unsaved records before closing a table. Access will not prompt you 
to save them when you close the table.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To edit a record :  Editing records

To quickly edit any record within a table, simply 
click on it and type in your changes. However, 
Access also offers you the ability to find and 
replace a word within multiple records and to 
delete records entirely.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To edit a record :Cont’d:  To replace a word within a record:

You can edit multiple occurrences of the same word by using Find and 
Replace, which searches for a term and replaces it with another term.
You can edit multiple occurrences of the same word by using Find and 
Replace, which searches for a term and replaces it with another term.

I. Select the Home tab, and 
locate the Find group.

II. Select the Replace 
command. The Find and 
Replace dialog box will 
appear.
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4. Working with Tables
Cont’d
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To edit a record: Cont’d: Click the Find What:
box, and type the word you would like to find.
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4. Working with Tables
Cont’d
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To edit a record: Cont’d:

Click the Replace With: 
box, and type the word you would like to replace the original word.
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• Once records have been added to a table, they can be 
deleted or modified:

– In Datasheet view, click the row selector for the record(s) you want to 
delete and then click the Delete Record button on the toolbar 

• To change or modify a record:
– Place your cursor on the record and then on the field you want to change 
– You can then edit the field's value as you wish by typing in new data 

• You can switch from navigation mode to editing mode 
depending on what you want to do at the time.

– When you are editing a record, you are in editing mode, Otherwise you 
are in navigation mode

– Editing mode is indicated by a pencil symbol in the left margin of the 
datasheet view

4. Working with Tables
Cont’d

To Delete a Record:

Data Management 2 MS... Access Training by MRRD/NORPLAN
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To Delete a Record Cont’d:Select the entire record by clicking the 
gray border at the left side of the record.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To Delete a Record Cont’d:• Select the Home tab, and locate the Records group.
• Click the Delete command. The record will be 

permanently deleted.
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4. Working with Tables
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

To Delete a Record Cont’d:
The ID numbers assigned to records stay the same even after 
you delete a record. For example, if you delete the 34th 
record in a table, the sequence of record ID numbers will read 
"...32, 33, 35, 36..." rather than "...32, 33, 34, 35, 36...".
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 An alternate method for deleting a record
To Delete a Record Cont’d:

4. Working with Tables
Cont’d
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Resizing Fields and Rows:

4. Working with Tables
Cont’d

 To resize a field: Place your cursor over the right gridline 
in the field title. Your mouse will become a double arrow 
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Resizing Fields and Rows Cont’d:

4. Working with Tables
Cont’d

 Click and drag the gridline to the right to increase the field width or to the left to decrease the 
field width. Release the mouse. The field width will be changed.
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Resizing Fields and Rows Cont’d:

4. Working with Tables
Cont’d

Click and drag the gridline downward to 
increase the row height or upward to decrease 
the row height. Release the mouse. The row 
height will be changed.

 Place your cursor over the bottom gridline in the gray 
area to the left of the row. Your mouse will become a 
double arrow .

XP
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5. DEALING WITH EXISTING
DATABASE

Data Management 2 MS... Access Training by MRRD/NORPLAN
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 You will deal with an existing database in this section
first.

 You are not required to create a new database file at first.

 You will be provided with a prepared database file.

 Dealing with existing Database

5. Dealing with Existing Database

Data Management 2 MS... Access Training by MRRD/NORPLAN
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• When Access is launched you will see the Access window, with 
the task pane on the right side 

• From the task pane you can open an existing database by:
– Selecting the database you want from the list of Recently opened 

databases

– Selecting “Look in” list arrow to choose a database you want to open 
from a storage location

If you choose the Look in list arrow, you will browse to the correct location 
of your database, click on it, and then click on Open to open the database

 Dealing with existing Database Cont’d (open an existing Database):

5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN
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• When a database is opened, the Access window and the Database window 
will be displayed.

• The Access window contains a menu bar, a toolbar, a task pane, and a status 
bar. 

• In the Access window, use the task pane to create a new database or to open 
an existing database. 

– To create a new database, make a selection from the New section of the 
task pane 

– To open an existing database, select from the list of Recently opened 
databases or from the More files option

5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

 Dealing with existing Database Cont’d (The MS-Access Window):
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5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

 Dealing with existing Database Cont’d (The Ms-Access Window):
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• The Database window is the main control center for working 
with an Access database.

• The Database window contains a menu bar, an objects bar, and a 
groups bar.

– The Objects bar lists all the objects available in the database 
– The list of objects consists of tables, queries, forms, reports, pages, 

macros, and modules 
– You can click on any of the objects in the Objects bar to obtain a list of 

objects of that type

5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

 Dealing with existing Database Cont’d (The Database Window):
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• To open a table you must first open a database: 

– In the database window, select Tables on the objects bar

– In the list of tables, select the table you want to open and click on the 
Open button 

– When a table is open it is in Datasheet view, which shows the table's data 
as a collection of rows and columns

– Each row in the Datasheet view represents a record in the table 

5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

 Dealing with existing Database Cont’d
(Open an Access database table):
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• You can navigate through the records by using the 
navigation buttons displayed at the bottom of the 
Datasheet view window. 

• The navigation bar allows you to:
– Go to the first record in the table
– Go to the previous record in the table
– Go to the next record in the table
– Go to the last record in the table
– Create a new record for the table (sometimes called an append record)

5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

 Dealing with existing Database Cont’d
(Navigate a database table):
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5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

 Dealing with existing Database Cont’d (A Table in datasheet view):
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5. Dealing with Existing Database
Cont’d

Data Management 2 MS... Access Training by MRRD/NORPLAN

 Dealing with existing Database Cont’d 
(The Navigation bar buttons):
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• The Save button in Access differs from the Save button in other 
Windows programs.

• When you press the Save button in Access, you are saving the 
design of the Access objects and NOT the data itself. 
– Access saves data as it is entered

• For this reason, the location at which you are storing your 
database must always be accessible while working with a 
particular database. 
– If the database is located on a diskette, the diskette must be in the diskette 

drive at all times while working with this particular database

5. Dealing with Existing Database
Cont’d
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 Dealing with existing Database Cont’d 
(Learn how Ms-Access saves a database):
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5. Dealing with Existing Database
Cont’d
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 Dealing with existing Database Cont’d (Ms-Access Field Types):
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5. Dealing with Existing Database
Cont’d
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 Dealing with existing Database Cont’d (Ms-Access Field Types):
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6. CREATING NEW 
DATABASE

Data Management 2 MS... Access Training by MRRD/NORPLAN
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• You can create a new database by using a 
Database Wizard or by creating a new, blank 
database. 

• When you create a new database, you will need to 
create all the tables, queries, forms, and reports for 
the database. 

– This is the most flexible approach, since you will create 
all objects yourself

6. Creating New Database
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• To create a new, blank database without using the Database 
Wizard:

 Start Access

 Click Blank Database in the task pane

 In the dialog box, navigate to the location where you will save 
your database

 Enter the name of the database in the File name text box

 Click the Create button

 Create a database without using the Database Wizard

6. Creating New Database
Cont’d
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 Create a new table
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6. Creating New Database
Cont’d
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• When you create a table, you name the fields and define 
the properties for the fields. 
– The table structure is set up and modified in Design View

– In Design View, you will define each field that will be included in 
the table

• When all the fields have been defined, you will then 
specify which field(s) will be the primary key. 
– The primary key is not mandatory, but it is a good idea to assign 

one

 Define fields, and specify Table’s primary key
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6. Creating New Database
Cont’d
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 Client’s Data requirements and Determining Database Fields
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6. Creating New Database
Cont’d
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 Fields grouped into tables
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6. Creating New Database
Cont’d
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There are several ways to create a table, the 
following are two ways to do that.
Create Table in Design View

Create Table in DataSheet View
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6. Creating New Database
Cont’d

 Create Tables:

XP
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• Choose a field or fields to serve as the primary key 
for the table.

• A primary key must uniquely identify each record in 
the table.

• Primary keys can consist of more than one field.

• Primary keys with more than one field are called 
composite keys
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6. Creating New Database
Cont’d

 Create Tables Cont’d (choose a primary key):
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6. Creating New Database
Cont’d

 Create Tables Cont’d (create tables in Design View):
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1

2
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6. Creating New Database
Cont’d

 Create Tables Cont’d (create tables in Design View):
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6. Creating New Database
Cont’d

 Create Tables Cont’d (filling field’s information):
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After you fill the fields’ information, it is 
the time to give your table a name.  
Click the x in the corner.
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6. Creating New Database
Cont’d

 Create Tables Cont’d:
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6. Creating New Database
Cont’d

 Create Tables Cont’d (the Database Design View Window:

XP
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Click a row selector for the field you want to use 
as the primary key, and then click the Primary 
Key button on the toolbar.

After clicking the Primary Key 
button, a key symbol appears in the 
row selector to indicate the key field.
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6. Creating New Database
Cont’d

 Create Tables Cont’d (choosing a primary key):
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6. Creating New Database
Cont’d

 Create Tables Cont’d (Datasheet view with 2 records added):
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• The structure of a table can be modified after it has been created. 

• To delete a field, enter Design View, right-click on the field, and then 
click Delete Rows on the drop down menu. 

• To move a field, (you also do this in Design View) click on the field 
you want to move, and while holding your mouse button down, move 
the field to the desired location.

• To add a field in Design View, right-click the field where you want to 
insert the new field and then click Insert Rows on the dropdown menu.

Data Management 2 MS... Access Training by MRRD/NORPLAN

6. Creating New Database
Cont’d

 Create Tables Cont’d
(modify the structure of a table by deleting, moving, and adding fields):
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6. Creating New Database
Cont’d

 Create Tables Cont’d (moving a field in Design View):
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1. Right-click the row selector for the 
field you want to insert the new field 
in front of Start Date in this figure.

2. Select Insert Rows from the 
shortcut menu, and a new, blank 
row will be inserted before the 
row you selected, as shown below.

3. Enter the 
information for 
the new field.
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6. Creating New Database
Cont’d

 Create Tables Cont’d (adding a new field in Design View):
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• You can make additional modifications to the structure of a 
table by changing the properties of the table's fields. 
o For example, if you have a field that represents a currency value 

but you do not want to display dollar signs, you could change the 
format to a standard format 

o In the Design View, you will find a list of all formats available to 
you. You can make a selection from the list of options 

o Each data type has a separate set of options available in the Field 
Properties portion of the Table Design Window
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6. Creating New Database
Cont’d

 Create Tables Cont’d (change field properties in Design View):
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6. Creating New Database
Cont’d

 Create Tables Cont’d (changing field properties in Design View):

Field properties 
are changed in 
the Design View 
window.
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6. Creating New Database
Cont’d

 Create Tables Cont’d (Some useful Data Type information):
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• If the data you want in your database already exists in 
another Access database, you can copy the records from 
that database into your database. 

• You can use cut and paste to do this: 

– Open the database that contains the records you want to copy 

– Select the records you want to copy and then press the Copy button. This 
places the records onto the Windows clipboard 

– Open the database to which you want to copy the records and open the 
desired table to receive the copied records 

– Place your cursor on the next available row in the table and press the Paste 
button 

Data Management 2 MS... Access Training by MRRD/NORPLAN

6. Creating New Database
Cont’d

 Create Tables Cont’d (copy records from another Access database):
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• You can also import an entire table, including its 
structure, into another database.

• To import a database table:
– Click the File menu
– Point to Get External Data, and then Import 
– Locate and select the database and the table you want to 

import 

• This differs from the cut and paste method 
because you actually import the entire table, its 
structure, and its data.
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6. Creating New Database
Cont’d

 Create Tables Cont’d (import a table from another Access database):

XP

111
Data Management 2 MS... Access Training by MRRD/NORPLAN

6. Creating New Database
Cont’d

 Create Tables Cont’d (import a table from another Access database):

The Import Objects dialog box
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• If you choose to copy records from one table to 
another, it is very important that you first 
determine that the two tables have the exact same 
data structure.

– If the two data structures differ in any way, the copy will cause an error

• When you import, you are importing an entire 
table, including its data and its structure. 

– This is a good way to include a table in your database that was previously 
designed in a different database 

Data Management 2 MS... Access Training by MRRD/NORPLAN

6. Creating New Database
Cont’d

 Create Tables Cont’d (copy and import considerations):

XP

Create Tables in 

Data Sheet View
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6. Creating New Database
Cont’d

 Create Tables by Datasheet View:
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6. Creating New Database
Cont’d

 Create Tables by Datasheet View Cont’d:
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6. Creating New Database
Cont’d

 Create Tables by Datasheet View Cont’d
(renaming fields and changing data types):
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6. Creating New Database
Cont’d

 Create Tables by Datasheet 
View Cont’d

(switch between different 
modes):
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6. Creating New Database
Cont’d

 Some-keystroke techniques for navigation and editing modes:
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6. Creating New Database
Cont’d

 Relationship between Tables:
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6. Creating New Database
Cont’d

 Relationship between Tables Cont’d :
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6. Creating New Database
Cont’d

 Relationship between Tables Cont’d (after creating the relationship) :
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7. WORKING WITH 
FORMS

Data Management 2 MS... Access Training by MRRD/NORPLAN

7. WORKING WITH FORMS
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7. Working with Forms

 Introduction to Forms:

While you can always enter
data directly into database
tables, you might find it easier to
use forms. Using a form to enter
data lets you be certain that
you're entering the right data in
the right location and format.
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7. Working with Forms
Cont’d

Why use Forms?: Many of us fill out forms. 

 Forms are so popular because they 
are useful for both the person 
asking for the information and the 
person providing it. 

 They are a way of requiring 
information in a specific format, 
which means the person filling out 
the form knows exactly which 
information to include and where 
to put it.
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7. Working with Forms
Cont’d

 To open an 
existing form:

• Locate Navigation 
Pane.

• In the Navigation 
Pane, locate the form 
you would like to 
open. 

• Forms are marked 
with the icon.

• Double-click 
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• Forms allow us to create an interface that can be more user 
friendly and attractive than Datasheet View.

Underlying table

Form

First record from table 
visible in form

Data Management 2 MS... Access Training by MRRD/NORPLAN

7. Working with Forms
Cont’d
 Form vs. Datasheet View:
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• A form allows you to view your data one record at a 
time. 

• Forms are useful for maintaining, viewing, and printing 
records in a database. 

• You can create your own form in the Forms Design 
window or you can use the Forms Wizard to create a 
form. 

• The easiest way to create a form is to use the 
AutoForm Wizard. 
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7. Working with Forms
Cont’d

 Creating Form:
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• The AutoForm Wizard uses a table (or query) you 
select as the basis to create a form that displays all the 
fields of the table (or query).

• Once you have created your form, you can view the 
records one record at a time. 

• The form has a navigation bar just like the navigation 
bar you have already used in the Table or Query 
Datasheet view.

 Use the AutoForm Wizard to Create a form:
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7. Working with Forms
Cont’d
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7. Working with Forms
Cont’d

Ms-Access Form View:
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8. SORTING AND 
FILTERING 
RECORDS
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8. Sorting and Filtering Records

 Introduction:

Ms-Access gives you the ability to work 
with enormous amounts of data, which 
means it can be difficult to learn anything 
about your database just by glancing at it.

o Sorting and 
o filtering 

are two tools that let you customize how 
you organize and view your data, making 
it more convenient to
work with.
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8. Sorting and Filtering Records

 Introduction (to sort record):

There are many ways records can be sorted. For example, the information in 
a database belonging to a bakery could be sorted in several ways:

Orders could be sorted:
• by order date
• or by the last name of the customers 

who placed the orders.

Customers could be sorted:
• by name or 
• by the city or zip code where 

customers live.

Products could be sorted:
• by name, 
• category (pies, cakes, 

cupcakes, etc.), 
• or price.
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8. Sorting and Filtering Records

 Introduction (to sort records) Cont’d:

You can sort both text and numbers in two ways:

I. in ascending order 
II. or descending order. 

"Ascending" means "going up," so an ascending sort will arrange numbers 
from smallest to largest and text from A to Z. 
"Descending" means "going down," or largest to smallest for numbers and 
Z to A for text. 
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8. Sorting and Filtering Records

 To sort records an example:

Select a field in the cell 
you wish to sort by. In 
this example, we will 
sort by customers' last 
names.
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8. Sorting and Filtering Records

 To sort records an example Cont’d:
o Click the Home tab on the Ribbon, and locate the Sort & Filter group.
o Sort the field by selecting the Ascending or Descending command.
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8. Sorting and Filtering Records

 To sort records an 
example Cont’d 
(result of Ascending sorting):
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8. Sorting and Filtering Records

 To sort records an example Cont’d (saving and removing sorting):

To save the new sort, click the Save
command on the Quick Access 
toolbar.

After you save the sort, the records will stay 
sorted that way until you perform another sort 
or remove the current one.
To remove a sort, simply click the Remove 
Sort command.
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8. Sorting and Filtering Records

 Filtering Records: 

Filters allow you to view only the data you want 
to see. When you create a filter, you set criteria
for the data you want to display. 

The filter then searches all of the records in the 
table, finds the ones that meet your search 
criteria, and temporarily hides the ones that 
don't.
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8. Sorting and Filtering Records

 To create a simple Filter: 

Click the drop-down arrow 
next to the field you would 
like to filter by. We will filter 
by city, as we want to see a 
list of customers who live in a 
certain city.

XP

140
Data Management 2 MS... Access Training by MRRD/NORPLAN

8. Sorting and Filtering Records

 To create a simple Filter: 

o Select and deselect items one at a time by 
clicking their check boxes. 

o We will deselect all of the options except 
for Cary.

o Click Select All to include every item in the 
filter. 

o Clicking Select All a second time will 
deselect all items.

o Click Blank to set the filter to find only the 
records with no data in the selected field.

o Click OK.
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8. Sorting and Filtering Records

 To create a simple 
Filter Cont’d 
(result of filtering): 

The filter will be 
applied. Our customers 
table now displays only 
customers who live in 
Cary.
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8. Sorting and Filtering Records

 To create a simple Filter Cont’d (Toggle Filter): 

 Toggling your filter 
allows you to turn it on
and off. 

 To view records without 
the filter, simply click 
the Toggle Filter 
command.

 To restore the filter, 
simply click it again.
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8. Sorting and Filtering Records

 Creating a filter from a selection

Filtering by selection allows you to select specific data from 

your table and find data that is similar or dissimilar to it. For 
instance, if you were working with a bakery's database and 
wanted to search for all products whose names contained the 
word "chocolate", you could select that word in one product 
name and create a filter with that selection. Creating a filter with 
a selection can be more convenient than setting up a simple 

filter if the field you're working with contains many items.
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8. Sorting and Filtering Records

 Creating a filter from 
a selection Cont’d

a. Select the cell or data. 
b. All products that contain 

the word "chocolate" in 
their names.

c. Select the Home tab on the 
Ribbon.

d. locate the Sort & Filter 
group

e. Click the Selection drop-
down arrow
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8. Sorting and Filtering Records

 Creating a filter from 
a selection Cont’d
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8. Sorting and Filtering Records

 Creating a filter 
from a selection 
Cont’d
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8. Sorting and Filtering Records

 To create a simple Filter Cont’d (to Filter Number): 

 Click the drop-down 
arrow next to the field 
you would like to filter by.

 We want to filter the 
records in our menu items 
table by price, so we'll 
click the arrow in the 
Price field.
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8. Sorting and Filtering Records

 To create a simple Filter Cont’d (to Filter Number): 

The Custom Filter dialog box 
will appear. Type in the 
number or numbers you would 
like to use in your filter. We'll 
type "5" so the filter will 
show us only menu items that 
cost $5 or less. Click OK
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8. Sorting and Filtering Records

 To create a simple Filter Cont’d (to Filter Number): 

The filter 
result will be 
displayed as 
the this figure.
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9. DESIGNING A 
QUERY




